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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Implementation Guide provides information and instructions to help you work 
effectively with Oracle CRM Foundation.

This preface explains how this guide is organized and introduces other sources of 
information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Technical Service Representatives (TSR)

■ Customer Service Representatives (CSR)

■ System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

■ Understanding of the company business processes.

■ Knowledge of products and services as defined by your marketing policies.

■ Basic understanding of Oracle and Developer/2000.

■ Background in SQL, PL/SQL, SQL* Plus programming.
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Structure
This manual is a compilation of the implementation topics in the online help for 
Oracle CRM Foundation conpoments. It provides general descriptions of the setup 
and configuration tasks required to implement the Oracle CRM Foundation 
components successfully.

Related Documents
For more information, see the following manuals:

■ Oracle CRM Foundation Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual 

■ Implementing Oracle CRM : ERP Functional Checklist (available on Oracle 
MetaLink)

■ Implementing Oracle CRM : Foundation Functional Checklist (available on Oracle 
MetaLink)
x



Implementing Oracle Foundation HTML
Stack

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
                              Implementing Oracle Foundation HTML Stack 1



Setting Up the Oracle Foundation HTML Stack
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up the Oracle Foundation HTML Stack
After installation of the Oracle CRM Family Pack1, the system administrator is the 
only pre-defined user of the Oracle CRM applications. The system administrator 
must create a guest user, register the user and assign roles to the user. 

Prerequisites
Installation must be complete.

Steps
Perform the following steps to setup the HTML Stack.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Foundation HTML Stack Setup 
Step Description Window Name(s)

1 Yes Log in as the System Administrator Welcome

2 Yes Set up a Guest user account. Advanced > Properties

3 Yes Register the guest user as a valid user. Users > Create

4 Optional Define new roles for the guest user. Security> Permissions

Security > Roles

5 Yes Assign roles to the guest user. Users > Assign Roles

Related Documentation

Document Purpose
2 Oracle CRM Foundation Components Implementation Guide  



Setting up a Guest User and Registering a Guest User
Logging in as System Administrator
The system administrator is the only pre-defined user that is provided with Oracle 
CRM Applications. Use this procedure to login to Oracle CRM Applications.

Steps
1. Open the Welcome window by entering its URL, 

http://<host>:<port>/<docroot>/JTFdefaultlogin.jsp

host = where Apache Server is installed

port = the port on which the Apache Web listener is configured

docroot = the document root defined for the Apache Server

2. Enter sysadmin in the User ID field.

3. In the Password field, enter sysadmin.

4. Click GO.   

Setting up a Guest User and Registering a Guest User
Oracle Marketing owns an API that sends news items to the login page of the 
System Administrator Console. This API delivers the news to the login page after 
you have defined at least one guest user. Perform the following steps to setup a 
guest user.

6 Yes Assign Default Responsibilities to 
Business user and End user
Assign Default Roles to Business User 
and End User

Setup > Default 
Responsibilities
Setup > Default Roles

Step 
Number Required?

Oracle Foundation HTML Stack Setup 
Step Description Window Name(s)
Implementing Oracle Foundation HTML Stack 3



Defining a New Role
Steps
1. Login to the System Administrator Console as the sysadmin user.

2. Select the Advanced tab and click Properties.

3. Create the guest_username key with value set to the guest user’s username.

4. Create the guest_password key with value set to the guest user’s password.

5. Select the Users tab and click Create.

The Create User page opens.

6. Enter information in the appropriate fields to identify the guest user and the 
guest user’s password. 

7. Click Create to complete the process.

At this point you can assign a role to the guest user.

See also
Defining a New Role

Defining a New Role
You can define roles in addition to the pre-defined roles that come with the Oracle 
System Administrator Console. Use this procedure to define a role and map it to 
permissions.

Steps
1. Select the Security tab and click Roles.

The Roles window displays all roles that have been defined. Role names are 
displayed in alphabetical order. The first two or three letters of the role name 
indicates the name of the module that the activity is associated with. Click Next, 
Last, First or Previous to review all the roles

2. Enter a new role name in an empty Name field. 

Note: The guest user’s User Type must be either End User or 
Business User. When you select End User, the user id and password 
is automatically approved. When you select Business User, the 
System Administrator must approve the user id and password.
4 Oracle CRM Foundation Components Implementation Guide  



Assigning Roles to the User
The first two or three letters of the name should correspond to the two- or 
three-letter code of a module. Each role name must be unique.

3. Enter a description of the role in the Description field.

4. Click Update to complete the definition. 

The new role name is automatically filed in alphabetical order. 

5. Find the new role is the list of role names and click the role name.

The Role Mapping window opens to display two lists: Available Permissions 
and Assigned Permissions. The Role Name appears above the lists.

6. Select a permission from one list and click > or < to move it to the opposite list.

■ Click >> to move all Available Permissions onto the Assigned Permissions 
list.

■ Click << to move all Assigned Permissions onto the Available Permissions 
list.

7. Click Update to complete the role mapping.

Assigning Roles to the User
Use this procedure to assign roles with their associated permissions to the Guest 
user.

Steps
1. Select the User tab and click Assign Roles.

A Search field appears on the window.

2. Enter the first one or two letters of the Guest user’s name in the Search field and 
click Search.

The search results show a list of user names that begin with the letters you 
entered. Click Next, Last, Previous or First to review all the user names in the 
list.

3. Click the user name to which you want to assign roles.

The Role Mapping window opens to display two lists: Available Roles and 
Assigned Roles.

4. Select a role from one list and click > or < to move it to the opposite list.
Implementing Oracle Foundation HTML Stack 5



Assign Default Responsibilities and Default Roles
■ Click >> to move all Available Roles onto the Assigned Roles list.

■ Click << to move all Assigned Roles onto the Available Roles list.

5. Click Update to complete the task of assigning roles.

Assign Default Responsibilities and Default Roles 
Registration allows two types of user:

■ Business users– individuals who represent an organization

■ End users–individuals who are not associated with an organization 

The system administrator must assign a Default Responsibility to each type of user 
to implement the self-registration service. Use this procedure to assign a Default 
Responsibility to End users and Business users.

Steps
1. Select the Setup tab and click Default Responsibilities.

The Register Default Responsibility window opens.

2. Choose a user type and enter the appropriate IDs.

3. Click Submit to complete the Default Responsibility setup.

4. Select the Setup tab and click Default Roles.

The Select Account Type and Domain window opens. This window contains 
two lists: Account Type and Domains. 

Always use CRM_DOMAIN as the domain.

5. Select one item in each list and click Next.

The Groups window displays two lists: Available Roles and Assigned Roles.

6. Select one or more Available Roles and click > to move it to the Assigned Roles 
list.

The roles in the Assigned Roles list will be assigned to the user type you 
selected in step 3.

■ Click >> to move all Available Roles onto the Assigned Roles list.

■ Click << to move all Assigned Roles onto the Available Roles list.

7. Click Update to complete the role assignment.
6 Oracle CRM Foundation Components Implementation Guide  



System Profile Options
System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

■ JTF_PROFILE_DEFAULT_APPLICATION

■ JTF_PROFILE_DEFAULT_RESPONSIBILITY

■ JTF_PROFILE_DEFAULT_CSS

■ JTF_PROFILE_DEFAULT_BLANK_ROWS

■ JTF_PROFILE_DEFAULT_NUM_ROWS

■ JTF_PROFILE_DEFAULT_CURRENCY

■  JTF_ACCOUNT_TYPE_END_USER

■ JTF_ACCOUNT_TYPE_BUSINESS_USER

■ ICX_DATE_FORMAT_MASK

■ ICX_LANGUAGE

■ ICX_TERRITORY

■ ICX_CLIENT_IANA_ENCODING

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_PROFILE_DEFAULT_APPLICATION
Stores default application ID for user. Set at the User level. The default application 
ID is the application to which the user is directed after login.

Required

User can Admin Setting Levels

View Update User Responsibility
Applicati
on Site

X X X X X

Setting Description and Usage Considerations

 The default value at user level is 690 for sysadmin.
Implementing Oracle Foundation HTML Stack 7



System Profile Options
Profile Option JTF_PROFILE_DEFAULT_RESPONSIBILITY
Stores default responsibility ID for user. Set at the User level. The default 
responsibility is the responsibility with which the user is logged in.

Profile Option JTF_PROFILE_DEFAULT_CSS
Stores the style sheet preference for the User. Values come from fnd lookup, 
JTF-STYLE-SHEET-LOOKUP-TYPE.

Profile Option JTF_PROFILE_DEFAULT_BLANK_ROWS
Stores the default number of blank rows to be displayed to the user. Values come 
from fnd lookup, JTF_BLANK_ROWS_LOOKUP_TYPE.

Required

User can Admin Setting Levels

View Update User Responsibility
Applicati
on Site

X X X X X

Setting Description and Usage Considerations

The default value at user level is 21841 for sysadmin

Required

User can Admin Setting Levels

View Update User Responsibility App Site

X X X X X

Setting Description and Usage Considerations

The default value is JTFUCSS.CSS at sitelevel.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is 5 at site level
8 Oracle CRM Foundation Components Implementation Guide  



System Profile Options
Profile Option JTF_PROFILE_DEFAULT_NUM_ROWS
Stores the default number of rows to be displayed to the user. Values come from fnd 
lookup, JTF_DISPLAY_ROWS_LOOKUP_TYPE.

Profile Option JTF_PROFILE_DEFAULT_CURRENCY
Stores the default currency setting of the user. Value is the currency code from 
fnd_currencies_vl_view.

Profile Option JTF_ACCOUNT_TYPE_END_USER
Stores the application ID and responsibility ID to be granted for a newly registered 
end user. The Site-level value represents the application ID; the Application-level 
value represents the responsibility ID.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is 10 at site level

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is USD at site level

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
Implementing Oracle Foundation HTML Stack 9



System Profile Options
Profile Option JTF_ACCOUNT_TYPE_BUSINESS_USER
Stores the application ID   and responsibility ID to be granted for a newly registered 
business user. The Site-level value represents the application ID; the 
Application-level value represents the responsibility ID.

Profile Option ICX_DATE_FORMAT_MASK
Stores the date format mask. This profile is owned by AOL/J team.

Profile Option ICX_LANGUAGE
Stores the current/default language for the user. This profile is owned by AOL/J 
team.

Profile Option ICX_TERRITORY
Stores the current/default territory for the user. This profile is owned by AOL/J 
team.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
10 Oracle CRM Foundation Components Implementation Guide  



Workflows in Oracle Foundation HTML Stack
Profile Option ICX_CLIENT_IANA_ENCODING
Stores the charset encoding information at the site level. This profile is owned by 
AOL/J team

Workflows in Oracle Foundation HTML Stack
There are no Workflows associated with the HTML Stack.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
Implementing Oracle Foundation HTML Stack 11



Workflows in Oracle Foundation HTML Stack
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Implementing Oracle Resource Manager

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components, Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
 Implementing Oracle Resource Manager 13



Setting Up Oracle Resource Manager
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Resource Manager
In addition to the pre-defined Role Types and Role Information, you can define new 
Role Types and Roles.

Steps

Defining Role Types
A Role Type is a category of roles associated with a particular CRM module. Oracle 
Resource Manager is delivered with pre-defined Role Types for all CRM modules.  
Use this procedure to define additional custom Role Types for your enterprise.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Role Types.

The Application Object Library window displays existing Role Types.

2. Use the down arrow to scroll to the bottom of the list of Role Types.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Resource Manager Setup 
Step Description Window Name(s) AIW Reference

1  Optional Define Role Types Application Object Library: 
JTF_RS_ROLE_TYPE Lookups

N/A

2 Optional Define Roles Roles N/A

Related Documentation

Document Purpose
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Defining Roles
3. Enter the name of the new Role Type in the blank field at the bottom of the list. 

4. In the Meaning field, enter the CRM module for which this Role Type is created.

5. Choose File > Save to complete the Role Type definition.

Defining Roles
A Role may encompass one or more job descriptions and job titles. Use Roles to 
assign jobs to resources, resource groups and resource teams. Oracle Resource 
Manager is delivered with pre-defined Roles for all CRM modules. Use this 
procedure to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Resource Manager responsibility, navigate to Setup > Roles.

The Roles window displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the 
list of values.

3. Select the Active box to make the Role active. Select one or more of the job title 
boxes–Manager, Member, Admin, Lead–to associate the Role to job titles. 

4. Use one or more of the Job lines to describe jobs associated with the Role.

5. Select File > Save to complete the Role definition.

The new role name registers in the Role Name field in Resource Manager.

References
Creating and Defining Resources

Defining Dynamic Groups

Resource Role Boxes

Check Box Action

Member Identifies the role name as a member of the role type

Lead Identifies the role name as a lead for the role type
 Implementing Oracle Resource Manager 15



Defining Dynamic Groups
Defining Dynamic Groups
Determine the group values available to the user in Resource Manager. By defining 
the name, usage values, and effective dates of a group, you ensure the correct use of 
groups and limit the individuals who have access to create them. Use this procedure 
to define a dynamic group.

Prerequisites
None

Steps
1. In Resource Manager Navigator, double-click CRM Resources to expand the 

node.

2. Select Groups and click Open.

The Dynamic Groups window opens.

3. Define and enter a group name in the Name field. 

4. Select a group usage from the Usage field.

5. Select the effective dates for the group from the list of values in the Start and 
End fields.

6. Enter a brief description of the group name and usage in the Description field.

7. Save the group.

The new group name registers in the Group Name field in Resource Manager.

Guidelines
Alternatively, you can define a group name by entering a SQL statement in the SQL 
Statement field and saving. Clicking Check Syntax checks your code for syntax 
errors.

Active Identifies the role as active

Administration Identifies the role as administrative

Manager Identifies the role as managerial

Seeded (Read Only) Identifies the role type as seeded

Resource Role Boxes

Check Box Action
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Defining Teams and Groups
References
Creating and Defining Resources

Setting Resource Roles

Setting Profile Options
Resource Manager does not use profile options.  

Workflows in Oracle Resource Manager
Resource Manager does not use Workflow processes.  

Defining Teams and Groups
See the following procedures for customizing Resource Manager for your 
enterprise:

■ Defining Resource Teams

■ Defining Resource Groups
 Implementing Oracle Resource Manager 17



Defining Teams and Groups
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Implementing Oracle Notes

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
Implementing Oracle Notes 19



Post-Installation Set Up Tasks for Oracle Notes
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of Implementing Foundation, Course Description ID 8831.

Post-Installation Set Up Tasks for Oracle Notes
After the Foundation modules have been installed, you may perform the following 
optional tasks:

Setting Up Note Types
Oracle Notes comes with a set of predefined note types. You can create additional 
customized note types. You may also choose to not use the predefined note types  
Perform the following steps to create new note types.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Notes Setup 
Step Description Window Name(s)

1 Optional Set Up Note Types Notes Setup > Note Type 
Lookups 

2 Optional Map Note Types to a Source Notes Setup > Source and 
Note Type Mapping

3 Optional Set Up the Source Object Code Task and Escalation 
Manager > Setup

Related Documentation

Document Purpose
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Defining Note Types
Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Note Type Setup

The Application Object Library: Note Type Lookups form window opens.

4. Define the code, meaning, and description as desired.

You only need to define a tag for a new, customized note type.

5. Save this record when you have finished.

Defining Note Types
You can configure Notes so that the user has a limited selection of task types. When 
you provide a list of values for the Note Type fields, note creators cannot enter an 
incorrect value because all note type options are pre-defined. Use this procedure to 
define note types.

Prerequisites
None

Steps
1. On the application menu bar, click File and select Switch Responsibility.

The Responsibilities window opens.

2. Scroll to select Application Developer and click OK.

The Navigator - Application Developer window opens.

3. In the Functions tab, double-click Application to expand the node.

Note: To delete an existing note type, assign an end date to that 
note type.
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Mapping Note Types To a Source
4. Double-click Lookups to expand the node.

5. Select Common and click Open.

The Application Utilities Lookups window opens.

6. On the application menu bar, click View, point to Query by Example, and click 
Enter.

7. In the Type field, enter JTF_NOTE_TYPE.

8. On the application menu bar, click View, point to Query by Example, and click 
Run.

The application populates the window with existing type code information.

9. Scroll down and select the last record in the multi-record block.

10. Define and enter the code, meaning, description, and effective dates.

11. Save your record.

The new note type registers in the list of values for the note type field in the 
application.

Guidelines
To enable a note type, select Enabled for the corresponding note type row. Initially 
you can create the complete set of note types and enable specific types as desired.

Mapping Note Types To a Source
When you may map a note type to a source object,  you limit the visible note types 
for that source to the defined subset of note types. Perform the following steps to 
map note types to source code.

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Source and Note Type Mapping.
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Setting Up the Source Object Code and Context
The Source to Type Mappings form window opens.

4. Select a source to map from the Source list of values.

5. Select a note type to map to it from the Note Type list of values.

6. Save this record when you have finished.

Setting Up the Source Object Code and Context
Oracle Notes provides predefined documents or source objects. When you define a 
new document, you must associate Notes usage to the new document. On the Notes 
form, the document name appears in the Source list. Each item in the Source list has 
an associated context, which appears in the Related To list.  

Perform the following steps to define the source code usage as NOTES.  

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Task and Escalation Manager node.

3. Expand the Setup node.

4. Double-click Objects Meta-data.

The Tasks Setup: Object Type form window opens.

5. Perform one of the following tasks:

a. If the source object code you want to seed already exists, then define the 
usage as NOTES.

b. If the source object code is not defined, then you must define the source 
object code, the name, and select its details and usage. (Usage should be 
NOTES.)

6. Save this record when you have finished.
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System Profile Options
Use the following list to identify the profile option(s) that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

■ JTF_NTS_NOTE_STATUS

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_NTS_NOTE_STATUS
Sets the default note status.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

 User chosen Chose the default note status from the provided list of values.
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Implementing Oracle Calendar

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and functions 
for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these options in any sequence.

■ JTF_CAL_ACCESS_ALL_CALENDARS

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_CAL_ACCESS_ALL_CALENDARS
Set to provide access to other Resources’ calendars.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical 
Reference Manual

Contains table and view descriptions for all the Foundation 
components

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.

Related Documentation

Document Purpose
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Defining a Calendar
Defining a Calendar
See the following procedures in CRM Foundation online Help for defining and 
maintaining calendars:

■ Defining the Calendar 

■ Defining Availability (of resources) 

■ Defining Non-availability 

■ Assigning a Resource to a Calendar 

■ Assigning a Calendar to a Shift 

■ Assigning a Calendar to an Exception

■  Viewing the Datebook
 Implementing Oracle Calendar 27



Defining a Calendar
28 Oracle CRM Foundation Components Implementation Guide 



Implementing Oracle Territory Manager

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting Up Oracle Territory Manager
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of Implementing Foundation, Course Description ID 8831.

Setting Up Oracle Territory Manager
Prior to using Oracle Territory Manager, you must set up and configure a number of items 
including qualifiers, territory types, and the specific territories.

Prerequisites
None.

Steps
Perform the steps following to set up the Oracle Territory Manager.

 

Implementing CRM Applications Contains post-installation information on various CRM 
modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Action Window Name(s)

1 Yes Set up and/or define qualifiers.

 By default, all qualifiers are disabled. Before you 
use a qualifier to define territories, you must 
enable the qualifier. Use the Setup Qualifier 
window to enable or disable qualifiers.

You may also create your own qualifiers. See 
Creating Custom Qualifiers for details.

Setup Qualifier

2 Optional Define the territory types.

See Creating Territory types for details.

Create Territory 
Type

Related Documentation

Document Purpose
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Setting Up Oracle Territory Manager
Guidelines
The following flow chart illustrates the process of setting up the Oracle Territory 
Manager.

3 Yes Define the territories.

See Different Ways of Creating Territories for 
details.

Navigator

4 Yes Compile the rules using the generating rule 
engine.

This compiles all the rules you have defined into 
a Rule Engine (PL/SQL package). 

Generate Territory 
Package 
(Concurrent 
Program)

Step Required? Action Window Name(s)
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Setting Up Oracle Territory Manager
Territory Manager Set Up Flow Chart
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System Profile Options
Before setting up all your territories, set up two or three first. Genreate the package 
and test territory assignments to make sure that transactions are correctly assigned. 
When these few territories work correctly, continue setting up all territories.

Troubleshooting
You may find the following tips to be useful.

1. Always set up territories in hierarchical fashion. This is extremely critical for the 
Territory Manager to work properly.

2. Make the territories as generic as possible.

3. If you create a territory and do not assign resources to it, then the Territory 
Manager does not return this territory as a qualifying territory. 

This is useful if you want to define a territory merely as a place holder territory 
in the hierarchy. An example of this could be "CA Territory".

4. You can create your own module specific "Catch All." 

Create a territory with the highest rank and assign resources to it, but do not 
assign any qualifiers and values. In that case, the rest of the territories will then 
be defined as its children.

System Profile Options
Oracle Territory Manager uses one profile option, TERR:Multiple Winning 
Territories

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.
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Profile Option TERR:Multiple Winning Territories
This profile options sets the number of qualifying territories to return.

The system profile option TERR: Multiple Winning Territories controls how Oracle 
Sales assigns transactions to competing winning territories. This occurs whenever a 
transaction satisfies the criteria of more than one territory at any level in the 
territory hierarchy. 

This system profile has two possible values:

■ Multiple: Oracle Sales assigns a transaction to all winning territories. 

■ Single (the default setting): Oracle Sales assigns the transaction to a single 
territory at each level in the territory hierarchy. The rank of competing 
territories determines which territory is the winner.

Assume, for example, that your company organizes its territories by customer name 
and by geographical area. You have two company territories, IBM and Sun, and a 
postal code territory that encompasses all of the postal codes within the United 
States. 

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X

Setting Description and Usage Considerations

Single Winner

Multiple Winner

Select the most qualifying territory.

Select all qualifying territories.

Note that selecting the Multiple Winner option can impact performance.
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If a your company receives a transaction from an IBM branch within the Unites 
States, then that transaction satisfies the criteria for both the IBM territory and the 
postal code territory.

If TERR: Multiple Winning Territories is set to multiple, then Oracle Sales assigns 
the transaction to both territories.

If this system profile is set to single, then Oracle Sales assigns the transaction only to 
the IBM territory because the IBM territory has a higher rank.
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Implementing Oracle Tasks

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Dependencies for Tasks
The following Foundation modules must be implemented before implementing 
Oracle Tasks:

■ Resource Manager

■ Territory Manager

■ Calendar

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.
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Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Tasks
Oracle Tasks comes ready to use out-of-the-box, with a number of functions 
pre-defined for you. However, if desired, you can easily customize Oracle Tasks to 
meet your business needs.

Prerequisites
First install Oracle Tasks.

Steps
Perform the following tasks to customize Oracle Tasks for your specific needs.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Action Window Name(s)

1 Optional Create new Task Statuses if you want to 
customize task statuses.

See Defining Task Status for details.

Define Task Status

2 Optional Create new Task Priorities if you want to 
customize task priorities.

See Determining Task Priorityfor details.

Define Task Priorities
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Defining a Status Transition and Assigning Rules
Defining a Status Transition and Assigning Rules
In Oracle Tasks, you can define a group of tasks that must be performed and impose 
a sequence of statuses to the tasks. A status transition is the imposed sequence of 
statuses. 

For example, one status transition may dictate the following status sequence:

■ Open

■ Assigned

■ Working

■ Closed 

3 Optional Create new Task Types if you want to 
customize task types.

See Defining a Task Type for details.

Define Task Types

4 Optional Use the status transition model to restrict the 
status assigned to a task depending on the 
responsibility.

Set up the state transition model for each 
responsibility.

Define Task Statuses, 
click Define 
Transition

5 Optional Create new task date types.

The task data model provides three 
pre-defined date types:

■ Planned

■ Scheduled

■ Actual

However, depending on the usage, 
additional dates can be required.

For example, if a lead requires a follow-up 
date, you might set up a Follow-up Date 
type.

Define Date Types

6 Optional Use templates if the same set of tasks are 
created repeatedly.

See Designing Task Templates for details.

Define Templates

Step Required? Action Window Name(s)
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Defining Task Status
As each status in the sequence is completed, the subsequent status appears on the 
agent’s list.

In addition, you can define rules for each status transition. A status transition rule 
defines access and read-write privileges for the status transition. Rules can be 
associated to responsibilities, so that a manager may have more privileges than an 
agent.

Use the following procedure to define a status transition and assign it to a 
responsibility.

Prerequisites
Responsibilities must be created for the applications to which you are assigning 
Task Status and Task Status Transitions.

Steps
1. Login to the CRM Administrator responsibility.

2. Navigate to Task Manager > Setup > Task Status.

The Task Status window opens.

3. Click Define Transition.

The Status Transition window opens. 

4. Click the Rules tab and click the Rule Name field.

5. Select View > Find All to populate the Rules tab.

The Rules tab displays two lists: Current State and Next State. On any line, the 
task in the Next State list defines the task that immediately follows the task in 
the Current State list. Use this window to define the sequence of tasks in a rule.

6. To define a new rule, enter a value in the Rule Name field.

7. Click the Responsibilities tab to assign a Rule to a Responsibility.

8. Click OK to complete the association of rule to responsibility. 

Defining Task Status 
Limit the user’s task status choice by defining the list of status options and 
determining the employee type who has access to each type. Providing a list of 
values for the Task Status field prevents task creators from entering an incorrect 
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Defining Task Status
value, and gives them the flexibility to choose among a pre-defined template of 
status options. Use this procedure to define task status types for your users.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Status and click Open.

The Task Status window opens.

4. Define a type name and enter it in the Status field.

5. Enter a brief description of the status type in the Description field.

6. Enter the effective dates in the From and To fields.

7. Select task status flags.

For a detailed description of flag options, see the Task Status Flag Definitions 
table in the References section.

8. Optionally, define transition values that determine the user privilege for each 
status type.

Use this procedure to define transition values.

a. Click State Transition.

The State Transition window opens.

b. In the Rules tab, enter a name for the user privilege relationship in the Rule 
Name field.

c. Enter an initial and final status type for the user.

Use the initial and final status values to determine the user’s range for 
selecting task status.

d. In the Responsibility tab, enter the pre-determined rule name.

e. Enter a user type in Responsibility Name field and click OK.

A transition value stipulating user status privilege now exists.

9. Save your task status type.
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Determining Task Priority
The new task status and corresponding privileges register as lists of values for 
their fields in the application.

References

Determining Task Priority 
Determine task priority by choosing terms for varying levels of priority and setting 
an importance rating that corresponds with each term. Use this procedure to 
determine task priority for your users.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Priority and click OK.

Task Status Flag Definitions

Flag Definition

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
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Defining Task Type
The Task Priority window opens.

4. Define a name and enter it in the Priority field.

5. Enter a numerical value in the Importance field.

Choose an importance value from a larger defined scale of priority.

6. Enter a brief description of the priority value.

7. Enter the effective dates in the From and To fields.

8. Select Seeded to restrict the edit of task priority from future users.

9. Save your task type.

The new task priority registers as a lists of value for the Priority field in the 
application.

Defining Task Type 
You can configure Task Manager to limit the user’s selection of task types. When 
you provide a list of values for the Task Type field, the task creators cannot enter an 
incorrect value. Instead they choose from a pre-defined menu of task options. Use 
this procedure to define task types.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Types and click OK.

The Task Types window opens.

4. Define a name and enter it in the Type field.

5. Select from the list of values in the Workflow field.

The corresponding workflow path information populates the Task Workflow 
and Description fields.

6. Enter the effective dates in the From and To fields.

7. Enter a unit of measurement for effort in the UOM field.
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Defining Task Type
Use a measure of time to determine the UOM value.

8. Enter a number for the quantity of effort in the Qty field.

9. Select task type flags.

For a detailed description of flag options, see the Task Type Flag Definitions 
table in the References section.

10. If you want to define resource requirements from the Task Types window, then 
use this procedure.

a. Click Resource Requirement.

The Resource Requirements window opens.

b. Enter a resource name in the Name field.

c. Enter a number in the Required Units field.

Selecting the Enabled Flag activates the resource type for the corresponding 
task type.

d. Click OK.

The complete set of resource types now exists and register as lists of values 
for their task types when enabled.

11. Save your task type.

The new task type and corresponding resource types register as lists of values 
for their fields in the application.

References

Task Type Flag Definitions

Flag Definition/Action

Notification Launch notification workflow automatically.

Schedulable Reserve the resource via the Scheduler.

Billable Signify a task as a service that requires billing.

Private Restrict task availability.

Seeded Lock edit of task type from future users.
44 Oracle CRM Foundation Components Implementation Guide 



Designing Task Templates
Designing Task Templates
Design a task template to assist the application user in creating tasks. When you 
create a template, you eliminate the user’s interaction with the specific properties of 
a task. This makes task creation a simple and quick process when creating 
redundant task types. Use this procedure to design task templates.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Tasks to expand the node.

3. Select Task Template Group and click OK.

The Task Template Group window opens.

4. Define and enter a template group name, description and effective dates.

5. Enter a document type by selecting from the list of values.

6. Define and enter a template name, number, and description.

7. Select from the list of values in the Type, Status, and Priority fields.

8. Activate alarm and notification functions, and enter duration and planned 
effort values.

9. Select flags.

10. Optionally, click Dependencies and Recurrences.

The Task Details window opens.

11. Save your template.

A task template now exists and task creation from a template is possible.

Guidelines
Create task templates within groups. Each task template group contains related task 
templates with full property descriptions.

References
Linking Tasks to Source Documentation 
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System Profile Options
Defining Task Type

Defining Task Status 

Determining Task Priority

Setting Task Flags 

Setting Dependencies for Tasks 

Assigning and Scheduling Resources 

Creating and Updating Tasks

System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

■ JTF_TASK_DEFAULT_TASK_TYPE

■ JTF_TASK_DEFAUT_TASK_STATUS

■ JTF_TASK_DEFAULT_TASK_PRIORITY

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_TASK_DEFAULT_TASK_TYPE
Sets the default task type.

Profile Option JTF_TASK_DEFAUT_TASK_STATUS
Sets the default task status.

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X
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Workflows
Profile Option JTF_TASK_DEFAULT_TASK_PRIORITY
Sets the default task priority.

Workflows
Oracle Tasks contains one pre-defined workflow:

■ JTFTASK

This workflow is automatically launched under the following circumstances.

■ If the auto-notification flag for the task type is set to Y (Yes).

■ If certain pre-defined conditions are met.

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X
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Implementing Oracle Interaction History

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Release Dependencies
Before Oracle Interaction History is installed, these items must be installed and 
stable: 

■ Oracle CRM Foundation (JTF) Resource

■ JTF Tasks

■ Oracle Accounts Receivable/Technical Community Architecture (AR/TCA) 
Customer Model

■ Oracle Automated Marketing Services (AMS) Campaigns

Implementation of Oracle Interaction History starts with:

■ The graphical user interface, either Forms or JSP versions

■ Interaction History Administration, either Forms or JSP versions, or public APIs

Oracle Interaction History interacts with JTF Resource; JTF Tasks; AR/TCA 
Customer Model; AMS Campaigns.

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i
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Setting Up Oracle Interaction History
■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Interaction History

Overview
Interaction History is a collection of tables and business logic that records touch 
points between customers and resources for Oracle Applications. Whether the touch 
point occurs between two computers, a face-to-face conversation, or over various 
media channels (such as telephony), the following patterns are true: 

■ A touch point is recorded as an interaction

■ An interaction is composed of a set of one or more business activities

■ An interaction is historical record, once created it cannot be altered or modified

■ Business activities can be related to a media item (such as phone, email, or fax 

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components
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Setting Up Oracle Interaction History
Prerequisites
Interaction History is part of the Oracle CRM Foundation product suite. After CRM 
Foundation is installed, clients can access the Interaction History graphical 
interface, Administration, and public APIs to test and use Interaction History 
functionality.

Steps

Step 
Number Required?

Oracle Interaction History Setup 
Step Description

Window 
Name(s) AIW Reference

 1 Optional Define additional Outcome Codes required by 
the application in addition to the initial seeded 
values. Modify or delete existing Outcome 
Codes.

Outcomes Tab CRM Administrator 

Interaction History 
Administrator 

 2 Optional Define additional Result Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Result codes.

Result Tab CRM Administrator 

Interaction History 
Administrator 

 3 Optional Define additional Reason Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Reason Codes

Reason Tab CRM Administrator

Interaction History 
Administrator 

4 Optional Define additional Action Item Codes required 
by the application in addition to the initial 
seeded values. Modify or delete existing Action 
Item Codes.

Action Item 
Tab

CRM Administrator 

Interaction History 
Administrator 

5 Optional Define additional Action Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Action codes.

Action Tab CRM Administrator

Interaction History 
Administrator 

6 Optional Define the Outcome, Result, and/or Reason 
codes as required for specific campaigns and 
promotions. 

Wrap Up Tab CRM Administrator 

Interaction History 
Administrator 

7 Optional Define unique pairs of Outcome-Results from 
existing Codes in the Outcome and Result 
tables.

Outcome 
Results

CRM Administrator

Interaction History 
Administrator

8 Optional Define unique pairs of Result-Reason from 
existing Codes in the Result and Reason tables.

Result Reasons CRM Administrator 

Interaction History 
Administrator 
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Troubleshooting Implementation of Oracle Interaction History
Guidelines
All applications that have a touch point between a customer and resource must 
record this event as an interaction via Oracle Interaction History or another 
application serving as a proxy that uses Interaction History (for example, Universal 
Work Queue). Interaction History records can be browsed and retrieved by directly 
using its graphical interface, integrating its graphical interface into an application, 
or using its views. Use the Administration tool to modify setup data; do not modify 
Interaction History tables directly.

Browsing and retrieval of interactions can be integrated by invoking the Interaction 
History graphical interface directly from an application, integrating the Interaction 
History graphical interface into an application, or using Interaction History views 
and displaying the results as needed by the application. 

Upon initiating a touch point, an interaction is created to serve as a repository for a 
set of business activities that will occur during the lifetime of the touch point. When 
a business activity is initiated, it is added to the interaction. After all business 
activities for the interaction are completed the interaction is closed, making it a 
historical record. Interactions can be browsed and retrieved during future active 
touch points or for business intelligence analysis. Media items associated with a 
business activity of an interaction are created before the interaction.

Concerns
Oracle Interaction History does not have any organizational constraints on 
operations or relationships. Oracle Interaction History does not have any 
multi-organizational tables.

Oracle Interaction History schema does not contain any table columns that are 
related to currency. Interaction History does have five translated tables which are 
used by applications for creating interactions and activities: JTF_IH_OUTCOMES; 
JTF_IH_RESULTS; JTF_IH_REASONS; JTF_IH_ACTION_ITEMS; 
JTF_IH_ACTIONS. 

Troubleshooting Implementation of Oracle Interaction History
The following problems may result in incorrect behavior for Interaction History:

■ Cannot create an interaction – mandatory parameters that must be validated. 
To create an interaction, a valid party_id (customer), resource_id (agent), 
outcome_id, and handler_id (application) are required. If any of these 
parameters are invalid or missing, the create interaction APIs will fail.
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Setting Profile Options
■ Cannot create an interaction – optional parameters that must be validated. 
To create an interaction, the following optional parameters must be valid: 
result_id, reason_id, and campaign.

■ Cannot create an activity – mandatory parameters that must be validated.
To crate an activity, a valid interaction_id, action_item (business activity type) 
and outcome_id are required. If any of these parameters are invalid or missing, 
the create activity APIs will fail.

■ Cannot create an activity – optional parameters that must be validated.
To create an activity, the following optional parameters must be valid: result_id, 
reason_id, action_id (sub-level detail related to business activity), media_id, 
task_id, cust_account_id, and campaign.

■ Cannot create a media item – mandatory parameters that must be validated. 
To create a media item, a valid media item type and media data are required. If 
any of these parameters are invalid or missing, the create interaction APIs will 
fail.

■ Cannot create an interaction, activity, or media item – failure to load 
mandatory parameter seed data. 
It is impossible to create an interaction if one of the following tables does not 
cannot seed data: outcomes and action items. These parameters must be 
validated.

■ Cannot create an interaction, activity, or media item - failure to load optional 
parameter seed data: It is impossible to create an interaction if one of the 
following tables does not cannot seed data: results, reasons, and actions. It these 
parameters are set, then they must be validated.

References
Oracle CRM Foundation Components - Interaction History High-Level Design Document

Oracle CRM Foundation Components - Concepts and Procedures, Release 11i, April 2000, 
Part No. A83642-01

Setting Profile Options
Oracle Interaction History does not use profiles.
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Workflows in Oracle Interaction History
Workflows in Oracle Interaction History
 Oracle Interaction History does not use workflows.
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Implementing Oracle 1-to-1 Fulfillment

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Release Dependencies
Before Oracle 1-to-1 Fulfillment is installed, these items must be installed and stable:

■ Oracle CRM Foundation HTML Stack

■ Oracle Interaction History

■ Oracle Marketing Encyclopedia Foundation Component (MES)

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.
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Setting Up Oracle 1-to-1 Fulfillment
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle 1-to-1 Fulfillment

The Oracle Foundation HTML Stack provides the interface for  Oracle 1-to-1 
Fulfillment. When the HTML Stack is implemented, no further setup is required for 
Oracle 1-to-1 Fulfillment.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle 1-to-1 Fulfillment Setup 
Step Description Window Name(s)

1 Yes Assign the JTF_FM_Admin role to the application 
administrator user.

Assign the JTF_FM_Administrator responsibility to the  
same user.

System Administrator > 
Security > User 

System Administrator > 
Security > User > Define

2 Yes Identify the agents and the output devices you will use 
with Oracle 1-to-1 Fulfillment

N/A

3 Yes Define Oracle 1-to-1 Fulfillment server(s) 1-to-1 Fulfillment System 
Administration > Server

4 Yes Define the resource groups for each output device and 
assign groups to servers

Fulfillment Administrator 
> Groups
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Assign the JTF_FM_Admin Role to the Administrator
Assign the JTF_FM_Admin Role to the Administrator
The JTF_FM_Admin role for the Oracle 1-to-1 Fulfillment administrator has been 
pre-defined. Use the following procedure to assign the role to the appropriate user.

Prerequisites
The Oracle 1-to-1 Fulfillment administrator must be defined as a user and have a 
password. The administrator must have the JTF_FM_ADMINISTRATOR 
responsibility assignment.

Steps
1. Use the HTML environment to login as sysadmin.

2. In the System Administrator Consol, select the Users tab > Assign Roles.

3. Enter the user ID of the Oracle 1-to-1 Fulfillment administrator in the Search 
field and click Go!

4. Click the user ID to open the User-Role Mapping window.

The Role Mapping window displays two lists: Available Roles and Assigned 
Roles.

5. Select the JTF_ADMIN role from the Available Roles list and click > to move it 
to the Assigned Roles list.

6. Click Update to complete the task of assigning the Administrator role to the 
Oracle 1-to-1 Fulfillment administrator.

5 Yes Create and upload Master Document(s) Fulfillment Administrator 
> Master Document > 
Upload

6 Yes Associate Master Document with Template Fulfillment Administrator 
> Template > Master 
Document 

7 Yes Set Up and Start the Fulfillment Server Oracle Applications

Step 
Number Required?

Oracle 1-to-1 Fulfillment Setup 
Step Description Window Name(s)
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Assign the JTF_FM_Administrator Responsibility to the Application Administrator
Assign the JTF_FM_Administrator Responsibility to the Application 
Administrator

When Oracle CRM Applications are first installed, the sysadmin user is the only 
defined user. The JTF_FM_Administrator responsibility has been predefined. You 
must assign this responsibility to the user who is the administrator for Oracle 1-to-1 
Fulfillment. Use this procedure to assign the JTF_FM_Administrator responsibility 
to the appropriate user.

Prerequisites
The Oracle 1-to-1 Fulfillment administrator user must be a registered user with a 
password. See Assign the JTF_Admin Role to the Administrator.

Execute SQLPLUS commands to determine two values in your database:  
responsibility_id for the jtf_fm_administrator key, and application_id for jtf. 

Steps
1. Use Oracle Forms to login as the System Administrator and navigate to 

Security > User > Define.

2. Enter the Oracle 1-to-1 Fulfillment administrator’s user ID in the User Name 
field.

3. Enter the Oracle 1-to-1 Fulfillment administrator’s password  in the Password 
field.

4. Choose JTF_FM_ADMINISTRATOR from the Responsibility list of values.

5. Select File > Save and Proceed, then close this window.

6. In the System Administrator window, navigate to Profile > System.

Note: To find the value of the responsibility_id for the
 jtf_fm_administrator key in your database, execute the following 
SQLPLUS command:

SELECT RESPONSIBILITY_ID FROM FND_RESPONSIBILITY 
WHERE RESPONSIBILITY_KEY = ’JTF_FM_ADMINISTRATOR’;

To find the value of the application_id for jtf in your database, 
exectute the following  SQLPLUS command:

SELECT APPLICATION_ID FROM FND_APPLICATION WHERE 
APPLICATION_NAME = ’JTF’;
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Define and Configure the Fulfillment Servers
7. In the Find System Profiles window, select the User box and select the  Oracle 
1-to-1 Fulfillment administrator’s user ID from the list of values.

8. In the Profile list of values, enter JTF% and click Find.

9. Modify the following profiles by entering values in the User column:

■ JTF_PROFILE_DEFAULT_APPLICATION: enter the value of the 
application_id used in your database 

■ JTF_PROFILE_DEFAULT_RESPONSIBILITY: enter the value of the 
responsibility_id used in your database

■ JTF_PROFILE_DEFAULT_LANG: enter US

10. Select File > Save and Proceed and return to the Find System Profiles window.

11. In the Profile list of values, enter ICX% and click Find.

12. Select ICX: LANGUAGE and set the language to your language.

13. Select File > Save.

The Oracle 1-to-1 Fulfillment administrator now has been assigned the 
appropriate responsibility.

Define and Configure the Fulfillment Servers
The fulfillment server calls on database tables to supply the fulfillment collateral, 
and sends the collateral to specified output devices. You need to configure the 
fulfillment server with specific output devices and  associate the output devices 
with specific agent groups.

When creating a new fulfillment server, you can follow the procedures that are 
listed on the screen in the Servers column. The procedures are listed in sequence, 
from top to bottom. 
Implementing Oracle 1-to-1 Fulfillment 59



Define and Configure the Fulfillment Servers
Prerequisites
None.

Steps
1. In Oracle 1-to-1 Fulfillment, choose the Server tab.

The Server screen opens. 

2. Choose the Create button. 

The General screen opens.

3. Enter the Server Name and other information as necessary.

■ In Start Time, enter the current date and the time of day that 
1-to-1 Fulfillment should begin operations. The Start time should occur 
after the date and time that the server is created.

■ In Shut Down Time, enter a date and the time of day that 1-to-1 Fulfillment 
should end operations. 

■ The Description is optional.

4. Click Continue. 

See Also
■ Configuring Email Servers

Note: Time format on the Server must be defined as yyyy-MM-dd 
HH:mm:ss.S, where:

■ yyyy is the year in four digits

■ MM is the month in two digits (06)

■ dd is the day in two digits (04)

■ HH is the hour, in two digits (from 01–24) 

■ mm is the minutes in two digits

■ ss is the seconds in two digits

■ S is milliseconds in one digit 

Enter a space between dd and HH.
60 Oracle CRM Foundation Components Implementation Guide



Configuring Email Servers
■ Configuring File Servers

Define Resource Groups and Assign Groups to Servers
A resource group is a group of people. Each resource group must be assigned to a 
Oracle 1-to-1 Fulfillment server. Use the following procedure to define a group and 
assign it to a server.

Prerequisites
A Oracle 1-to-1 Fulfillment server must be defined and configured. Agents must be 
registered users. 

Steps
1. In the 1-to-1Fulfillment Administrator Console, choose the Server tab and then 

click Groups > Create.

The Create Group window displays the fields you need to create a resource 
group.

2. Enter the Group Name and Description. Select the appropriate Server from the 
list.

3. In the list of Agents, click Go  to begin a search of Agents.

The Select Agent window.

4. In the Select Agent window, enter the initial letter of the agent’s name with  % 
and click Search.

5. Click the agent name to add the agent to the group. Repeat steps 3 and 4 for 
each of the agents you want to include in the group.

6. When the list of agents is complete, click Create.

Configuring Email Servers
After you configure the fulfillment server, you can associate the e-mail server with 
the fulfillment server. 

Prerequisites
You must have already created the server. To begin, see Define and Configure the 
Fulfillment Servers.
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Configuring Fax Servers
Steps
1. In the Email Servers screen, choose the Add button to add a new Email server.

 The Create Email Server screen opens.

2. In the fields, enter required information about the Email server that you want to 
add. In the Incoming and Outgoing server fields, enter the imap or smtp server 
names.

3. Choose Save.

You return to the Email Servers screen.

4. To add more Email servers, repeat steps 1, 2 and 3.

Configuring Fax Servers

Configuring File Servers
After you create a fulfillment server you can associate a file server with the 
fulfillment server. Follow this procedure to configure a file server.

Prerequisites
You must have already created the fulfillment server. To begin, see Define and 
Configure the Fulfillment Servers.

Steps
1. On the Servers tab, click the name of the Fulfillment server to which you want 

to associate a file server.

The General window opens and displays a list of server types on the left side of 
the window.

2. Click File Servers.

WARNING:  Screens relating to either print or fax functionality 
or capability are not supported, and should not be used.

Note: The fulfillment server creates a file for each request. The 
filename  reflects the request identity. Do not enter a filename in the 
directory field.
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Creating Groups for Servers
The File Servers window displays fields labeled Directory and Description.

3. In the Directory field, enter the full path to the server which you want to 
associate to the Fulfillment server.  

Optionally, you may enter a description in the Description field. The server can 
create any directory structure that you enter, even if it does not currently exist.

4. Click Update to complete the association.

Guidelines
Only one file server can be configured for a fulfillment server. 

If a group is associated to a a fulfillment server, all agents that belong to that group 
have accesss to the file server that is associated to the server. See Creating Groups 
for Servers.

When you resubmit a request for a file server, the new request will erase  and 
replace the pre-existing request file.

Configuring Printers

Creating Groups for Servers
The last step in configuring the fulfillment server is to associate agent groups with 
the fulfillment server, and associate output devices with the groups. By associating 
a group to an output device, you indicate that the group will use that device. You 
must create an association for each agent group to each output device for which the 
group needs access. Use this procedure to  associate an agent group to one or more 
output devices.

WARNING: Screens relating to either print or Fax functionality 
or capability are not supported, and should not be used.
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Creating a New Template
Prerequisites
You must have already created the fulfillment server. See  Define and Configure the 
Fulfillment Servers.

Steps
1. To add a group, in the Groups screen, choose the Add button.

The Select Group screen opens.

2. From the Group Name drop-down list, choose a group to associate with the 
fulfillment server.

3. Choose Go. 

The Output Devices screen opens to display a list of output device types. You 
must create an association with each output device to which the group needs 
access.  

4. From the list of values for one type of output device, choose one or more 
devices that you want to associate to the group. 

5. Click Create to create the association. Or click Clear to clear associations that 
you have selected but have not yet created.

6. Repeat step 5 and 6 for each type of output device you want to associate to the 
group.

7. Click Save to complete the association of the group to output devices.

See also
Creating New Groups

 Adding Agents to a Group

Creating a New Template
A template is a pre-defined package of brochures, newsletters, or other 
customer-oriented information that an agent can direct to customers in response to 
a fulfillment request. Text found in a template is associated to one or more master 

Note:  When a group is associated to a fulfillment server, that 
server’s file server is automatically available for the group. You do 
not need to associate a file server to a group or its agents.
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Upload Master Documents
documents. For more information on templates and how to use them, see 
Understanding Fulfillment Templates. 

To create a new template, use the following procedure.

Prerequisites
You must first create Master documents and upload them.

Steps
1. Choose the Template tab and then choose Create.

The General screen opens.

2. Enter a Template Name.

3. In the Status drop-down list, choose either: 

■ Active to make the template available to requests.

■ Inactive to make the template unavailable to requests.

4. Optionally, in the Description field you may enter a description of the template.

5. Click Save.

The Template Master Document screen opens.

Upload Master Documents
A Master Document contains text that is used repeatedly, such as a form or a 
contract. You create Master Documents on a word processing application. A Master 
Document may have one of the following extensions:

■ .zip

■ .html

After you have created a Master Document, you upload it into Oracle 1-to-1 
Fulfillment. Use the following procedure to upload a Master Document.
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Associate a Master Document to a Template
Prerequisites
One or more Master Documents must exist.

Steps
1. In the 1-to-1Fulfillment Administrator Console, choose the Template tab and 

then click Master Document.

2. Click Upload in the top of the window.

The Upload Master Document window opens.

3. Click Browse to find the Master Document you want to upload.

4. When the Filename field contains the name of the Master Document, click 
Upload.

Associate a Master Document to a Template
A template is a pre-defined package of brochures, newsletters, or other 
customer-oriented information that an agent locates and directs to customers in 
answer to a fulfillment request. Use the following procedure to associate one or 
more Master Documents to a template.

Prerequisites
One or more Master Documents must exist be available in the list of Master 
Documents.

Steps
1. In the Fulfillment Administrator Console, choose the Template tab.

The View Template window opens.

2. Click a template name.

The template details window opens.

3. Click Master Document in the left frame.

Note: If the Master Document in HTML was originally created in 
Microsoft Word, you must use the Notepad or an HTML text editor 
to remove information that is proprietary to Microsoft from the 
HTML header.
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Inserting Collateral into a Template
The View Template, Master Documents window opens.

4. Choose Go to begin a search of master documents.

5. In the Master Documents window, enter the initial letter of a master document 
with  % and click Search.

6. Click on the name of the Master Document.

The selected Master Document is now associated with the Template.

Adding a Master Document to a Template
To add a master document to a template, use the following procedure.

Prerequisites
The template must already exist. See Creating a New Template.

Steps
1. Choose the Template tab.

The View Template screen opens.

2. Choose the name of the template that you want to add.

The template details screen opens.

3. Choose the Master Document link in the left frame.

The View Template, Master Documents screen opens.

4. Choose Go to add more master documents.

5. Choose Update to save.

Inserting Collateral into a Template
To add collateral to a template, use the following procedure.

Prerequisites
None.

Steps
1. Choose the Template tab.
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Setting Up and Starting the Fulfillment Server
The View Template screen opens.

2. Choose the name of the template that you want to update.

The template details screen opens.

3. Choose the Collateral link in the left frame.

The View Template, Collateral screen opens. 

4. Choose Go to add more collateral.

5. Choose Update to save.

Setting Up and Starting the Fulfillment Server
Use the following procedure to set up the server.

Steps
1. Modify the classpath so that it points to both apps.zip and 3rdparty.zip

2. Create a simple batch file, or UNIX shell script, from which the server can be 
configured and executed.

Here is a batch file example:

java-ms32m-mx64m-nojit (for UNIX shell script,  add exec to the beginning of the 
line)

-Dengine.OutputDir=output
-Dengine.CommandPromptEnabled=true
-Dengine.ServerID=999
-Dengine.AOLJ.config= <path>\jtf.dbc
oracle.apps.jtf.fm.engine.processor.Processor

engine.OutputDir is the output directory to be used by the Fulfillment 
Dispatcher. Early versions of Fulfillment Server may not have this feature.

engine.CommandPromptEnabled must be set to true if you want to interact 
with the Fulfillment Server via the command prompt.

engine.ServerID specifies the ID of the server.

Note: Perform the following procedure in either a UNIX or 
Windows-NT environment.
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System Profile Options
engine.AOLJ.config is the location of the ’jtf.dbc’ file that the server needs 
to be able to communicatelwith the database.

engine.refreshrate  (optional) is the number of milliseconds between the 
status checks that the processor performs.

3. Execute the batch file or UNIX shell script to start the Fulfillment Server.

Guidelines
Use the following Fulfillment Server commands:

stat –prints statistics on the current state of the fulfillment processor

stop –stops the fulfillment processor

System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

■ JTF_FM_TEMP_DIR

■ JTF_FM_OUT_DIR

■ JTF_FM_EVENTS_LOG

■ JTF_FM_ERROR_LOG

■ JTF_FM_LOG_LEVEL

■ JTF_FM_NUM_PROCESSES

■ JTF_FM_MIN_PROCESSES

■ JTF_FM_MAX_PROCESSES

■ JTF_FM_PROCESS_IDLE

■ JTF_FM_MAX_PROCESS_IDLE

■ JTF_FM_REFRESH_RATE

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_FM_TEMP_DIR
Sets the temporary directory for the fulfillment engine. (This is not a full path.)
Implementing Oracle 1-to-1 Fulfillment 69



System Profile Options
Profile Option JTF_FM_OUT_DIR
Sets the output directory for the fulfillment engine.

Profile Option JTF_FM_EVENTS_LOG
Sets the events log name for the fulfillment engine.

Profile Option JTF_FM_ERROR_LOG
Sets the error log name for the fulfillment engine.

Profile Option JTF_FM_LOG_LEVEL
Sets the level of logging detail.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
70 Oracle CRM Foundation Components Implementation Guide



System Profile Options
Profile Option JTF_FM_NUM_PROCESSES
Sets the number of engine processes at the start up of the fulfillment engine.

Profile Option JTF_FM_MIN_PROCESSES
Sets the minimum number of processes available at any given time in the 
fulfillment engine.

Profile Option JTF_FM_MAX_PROCESSES
Sets the maximum number of processes available at any given time in the 
fulfillment engine.

Profile Option JTF_FM_PROCESS_IDLE
The number of milliseconds a process is allowed to remain idle before the processor 
starts reducing to the minimum.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Workflows in Oracle 1-to-1 Fulfillment
Profile Option JTF_FM_MAX_PROCESS_IDLE
The number of milliseconds a process is allowed to remain idle before needing a 
refresh.

Profile Option JTF_FM_REFRESH_RATE
Description of profile option.

Workflows in Oracle 1-to-1 Fulfillment
Oracle 1-to-1 Fulfillment resides in lhe CRM Foundation area. The application that  
uses Oracle 1-to-1 Fulfillment can use four pre-defined workflows in jtffinwf2.wft.  

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Implementing Oracle Assignment Manager

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting System Profile Options
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these options in any sequence.

■ ACTIVATE_AUTO_SELECT

■ ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS

■ ACTIVATE_IB_PREFERRED_ENGINEERS

■ ACTIVATE_WORKFLOW_NAME

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Related Documentation

Document Purpose
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Setting System Profile Options
Profile Option ACTIVATE_AUTO_SELECT
Set to activate the auto-selection of resources by the Assignment Manger engine. 

The Assignment Manager engine uses this profile option setting to determine 
whether the user needs to make a selection from the provided list of resources, or if 
this task is performed automatically by the Assignment Manager engine itself.

Profile Option ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS
Set to retrieve the preferred resource information from the Contracts module.

The Assignment Manager engine uses this profile option setting to determine 
whether the Contracts Preferred Engineers are picked automatically by the 
Assignment Manager engine or not.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is Yes.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.
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Setting System Profile Options
Profile Option ACTIVATE_IB_PREFERRED_ENGINEERS
Set to retrieve the preferred resource information from the Installed Base module.

The Assignment Manager engine uses this profile option setting to determine 
whether the Installed Base Preferred Engineers are picked automatically by the 
Assignment Manager engine or not.

Profile Option ACTIVATE_WORKFLOW_NAME
Set to a user-defined workflow procedure name. 

This workflow procedure is user-programmed code for further filtering the 
resources. The Assignment Manager engine retrieves the procedure name from this 
profile option and uses it to process the user’s request. 

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

None The name of a user-defined procedure.

There is no default. This is a user-defined procedure; it may or may not 
exist.
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Implementing Oracle Escalation Manager

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

■ Oracle Applications, Product Update Notes, Release 11i

■ Installing Oracle Applications, Release 11i

■ Implementing CRM Applications

■ Oracle CRM Foundation Components, Concepts and Procedures

■ Oracle CRM Foundation Technical Reference Manual

■ Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting Up Oracle Escalation Manager
Related Courseware
The following Net Class is available on demand through Oracle University.

■ 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Escalation Manager
Oracle Escalation Manager provides two types of escalation management:

■ Reactive, or activity in response to a customer behavior

■ Proactive, or an automated response to a violation of business rules

A Workflow process controls the Business Rule Monitor, which in turn periodically 
checks the business rules that have been defined. The user that owns this Workflow 
process receives notifications when the process starts and stops, and also when 
errors are detected. A user called JTFBRM must be defined to ensure that an owner 
of the Workflow process exists and that the notifications can be sent successfully.

Oracle Escalation Manager provides pre-defined business rules. You may design 
your own rules that have been customized for your enterprise.

Implementing CRM Applications Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online help 
system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Escalation Manager Setup 
Step Description Window Name(s)

 1 Yes Define the JTFBRM user Define Application User

2 Yes Start the Workflow Background 
Processes

System Administrator > 
Requests > Run

3 Yes Start the Business Rule Monitor CRM Administrator > 
Business Rule Monitor > 
Business Rule Monitor

Related Documentation

Document Purpose
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Start the Workflow Background Processes
Defining the JTFBRM User
Automated escalations in Oracle Escalation Manager are triggered by Workflow 
processes. JTFBRM user is the user who has responsibility for managing the 
Workflow processes. Escalations in Oracle Escalation Manager are triggered by 
Workflow processes. Use the following procedure to define the JTFBRM user.

Prerequisites
The user who will be designated as the JTFBRM user must be registered with a user 
ID and password.

Steps
1. In the System Administrator responsibility, navigate to Security > User > 

Define.

The Users window displays fields you use to define the user.

2. Enter JTFBRM in the User Name field.

The exact user name is JTFBRM.

3. Enter the JTFBRM user’s password in the Password field.

4. Choose Workflow User and Workflow Administrator from the Responsibility 
list of values.

5. Select File > Save and Proceed, then close this window.

Start the Workflow Background Processes
Proper operation of the Business Rule Monitor requires four Workflow background 
processes:

■ Business Rule Monitor Main Process

■ Business Rule Monitor Task Process

4 Optional Define a Business Rule CRM Administrator > 
Business Rule Monitor >

Business Rule Workbench

Step 
Number Required?

Oracle Escalation Manager Setup 
Step Description Window Name(s)
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Start the Workflow Background Processes
■ Business Rule Monitor Service Request Process

■ Business Rule Monitor Defect Process

Use the following procedure to start these background processes.

Prerequisites
None

Steps
1. In the System Administrator responsibility, navigate to Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and press the Tab 
key on your keyboard.

The Reports window opens and displays report names that begin with w.

4. Select Workflow Background Process and click OK.

The Parameters window opens.

5. Type bu in the Item Type field and press the Tab key on your keyboard.

The Item Type window opens and displays the four Workflow background 
processes required by the Business Rule Monitor.

6. Select one of the four Business Rule Monitor processes and click OK.

7. Leave the Minimum Threshold and Maximum Threshold fields empty.

8. Enter Yes in the Process Deferred field, enter No in the Process Timeout field 
and click OK.

The Submit Request window appears in front.

9. Click Schedule on the Submit Request window.

The Schedule window appears in front.

10. Select Run the Job...Periodically.

More options appear for defining the periodicity.

11. Define the Start time and the End time.
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Start the Business Rule Monitor
12. In the Rerun Every fields, enter the number of minutes that defines the interval 
between job runs.

13. Select the From the Completion of the prior run box.

14. Click OK.

15. Repeat this entire procedure for each of the four Workflow background 
processes.

Guidelines
As a test, allow these background processes to run for a while. When you are 
satisfied with their performance, you can modify the parameters to adapt to the 
needs of your enterprise.

Set up Notifications in Oracle Workflow to ensure that notifications are sent to 
email.

Start the Business Rule Monitor
The Business Rule Monitor monitors the Workflow processes. In the Business Rule 
Monitor, you indicate how often the monitor checks the rules. Use this procedure to 
start the Business Rule Monitor.

Prerequisites
The four Workflow background processes for the Business Rule Monitor must be 
started. If you have designed customized Workflow background processes, they 
must also be started.

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor > 

Business Rule Monitor.

The Business Rule Monitor opens.

2. Enter a number in the Interval field, enter a time unit–minutes or hours–in the 
UOM field.

Note: Be sure to define an End time. When the End time field is 
blank, the process runs indefinitely and cannot be shut off.
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Define a Business Rule
3. Click Save.

4. Click Start to start the monitor.

A Note tells you that the Business Rule Monitor was started successfully. The 
Item Key field and the Status field display values.

Guidelines
After the monitor is started, the Stop button appears. Click Stop to stop the monitor.

Click Refresh Status to get an immediate status on the Workflow background 
processes.

Define a Business Rule
In addition to the pre-defined business rules provided with Oracle Escalation 
Manager, you can define your own business rules. Use the following procedure to 
define a business rule.

Prerequisites
None.

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor > 

Business Rule Workbench.

The Business Rule Workbench opens.

2. Enter values in the Name, Object, Check Rule Every, Effective, and Workflow 
fields to define the business rule, its effectivity dates and the action that will be 
carried out. 

You can also define attributes for the Workflow and an Owner for the business 
rule. 

3. Use the Simple lines to define the conditions under which the business rule is 
triggered. 

The lines define a sequence of conditions.

4. Click Validate to check the syntax of the conditions you’ve defined in the 
Simple lines.

The syntax check will tell you whether or not the syntax works.
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Foundation Lookup Codes
5.  When the syntax of the defined conditions is validated, click Generate.

Escalation Territories
An escalation territory is a placeholder for resources that you want to put into 
service under certain conditions. Escalation territories are defined in Oracle 
Territory Management. Ensure that at least one resource is identified in the Catch 
All Escalation Territory.

See also
Escalation Territories

Creating Individual Territories

Foundation Lookup Codes
Set up Escalation foundation lookup codes. The suggested lookup codes for 
Escalation Reason and Escalation Level are:

■ JTF_TASK_ESC_LEVEL 

■ JTF_TASK_REASON_CODE

■ JTF_TASK_CONTACT_TYPE

■ JTF_TASK_REFERENCE_CODES

Lookup Code JTF_TASK_ESC_LEVEL 
Sets escalation levels.

Lookup Code JTF_TASK_REASON_CODE 
Sets escalation reasons.

Code Meaning

DE De-escalated

L1 Level 1

NE Never escalated
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Setting Up Escalation Status
Lookup Code JTF_TASK_CONTACT_TYPE 
Sets contract types.

Lookup Code JTF_TASK_REFERENCE_CODES 
Sets reference codes for the task.

Setting Up Escalation Status
There are three pre-defined Escalation Statuses: Open, Working, and Closed. You 
may add your own user-defined statuses to these available statuses. Use the 
following procedure to add user-defined statuses.

Prerequisites
None.

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Escalation Level.

2. Enter a user-defined status in a blank field in the Status column.

Code Meaning

SLOW-PROG Slow Progress

UNACCEPTABLE_SOLUTION Unacceptable Solution

UNRES_OWN Unresponsive owner

IMP_FAILING Implementation failing

Code Meaning

CUST Customer

EMP Employee

Code Meaning

ESC Escalation

FYI For your information
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Defining Escalation Reference Types
3. Enter a brief description of the status type in the Description field.

4. Enter the effective dates in the From and To fields.

5. Select escalation status flags.

For a detailed list of status flag options, see the Escalation Status Flag 
Definitions table in the References section of this procedure.

6. Click the Save icon to finish defining the Escalation status. 

References

Defining Escalation Reference Types
A document or task may be combined with several other documents or tasks, such 
as when fulfilling a service request requires a series of tasks to be performed and 
related documents to be completed. In such a scenario, if one particular document 
or task needs to be escalated, the escalation might not apply to the other related 
items. 

Escalation Status Flag Definitions

Flag Definition

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
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Defining Escalation Reference Types
When you associate an Escalation Reference to the escalated item, you point to the 
other related items and indicate their relation. There are two pre-defined Escalation 
Reference types: FYI and Escalation. 

■ Use FYI (for your information) to indicate the task or document is related to the 
escalated item, but is not escalated.

■ Use Escalation to indicate the task or document is related to the escalated item 
and also escalated.

You can add other Escalation Reference type to customize your escalation 
references. Use the following procedure to define customized reference types.

Prerequisites
None.

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Reference Code.

2. Enter the name of the new reference type in the first available row in the Code 
column.

3. Continue entering information in the remaining cells of the row to describe the 
escalation reference type and the effectivity dates.

4. Select the Enabled box to make the escalation reference type available.

Defining Escalation Reference Types
A document or task may be combined with several other documents or tasks, such 
as when fulfilling a service request requires a series of tasks to be performed and 
related documents to be completed. In such a scenario, if one particular document 
or task needs to be escalated, the escalation might not apply to the other related 
items. 

When you associate an Escalation Reference to the escalated item, you point to the 
other related items and indicate their relation. There are two pre-defined Escalation 
Reference types: FYI and Escalation. 

■ Use FYI (for your information) to indicate the task or document is related to the 
escalated item, but is not escalated.

■ Use Escalation to indicate the task or document is related to the escalated item 
and also escalated.
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Setting System Profile Options
You can add other Escalation Reference type to customize your escalation 
references. Use the following procedure to define customized reference types.

Prerequisites
None.

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Reference Code.

2. Enter the name of the new reference type in the first available row in the Code 
column.

3. Continue entering information in the remaining cells of the row to describe the 
escalation reference type and the effectivity dates.

4. Select the Enabled box to make the escalation reference type available.

5. Save the new Escalation Reference and close the form.

Setting System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Escalation Management Profile Settings

Profile Option Value

Default Escalation Status Open

Default Escalation Level Level 1

Default Escalation Reason Slow Progress

Default Document Type Service Request

Default Reference Type Escalation

Default Contact Type Customer

Default Contact Notify (Y/N) Yes

Default Customer Contact Point Phone
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Workflows in Oracle Escalation Manager
Workflows in Oracle Escalation Manager
There are five predefined workflow item types: 

■ JTFBRM - Business Rule Monitor Main Process

■ JTFBRMDF - Business Rule Monitor Defect Process

■ JTFBRMPR - Business Rule Monitor Task Process

■ JTFBRMSR - Business Rule Monitor Service Request Process

■ JTFEC-Reactive Escalation Notification

The first item type is internal to the Business Rule Monitor and has no user-defined 
attributes. The next three item types have specific attributes defined for each 
process. These attributes are maintained within the Business Rule Workbench 
screen. The last workflow item type is used for reactive escalation management.

Default New Note Type General

Default Employee Contact Point Work

Close Only When De-escalated (Y/N) Yes

Escalation Management Profile Settings

Profile Option Value
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